
       GOSTEAM Hands-on Activity Template (Inquiry-based) 

 

Title: 

Potential landing sites on the Moon and Mars for my rover 

Short Description (Max 500 words): 

Rigorous selection of a landing site for a Martian rover plays a crucial role in the success of the 

mission because it guides the rover to a location on Mars where the science objectives can be 

best achieved.  Selecting an optimal site is a complex multi-objective optimization problem 

enumerating a vast number of criteria. 

During this activity, we focus on certain surface-related parameters, including elevation, 

latitude and slopes in order to extract an optimal landing sites for a Martian rover! Do you think 

that’s an easy task? Let's find out! 

Keywords (Up to 5):  

Spatial Modelling, Surface Analysis, 3D terrain 

Information about the Implementation 

Age and language of the students:             9-12           12-15          15-18           18+ 

Language:  Greek   Age: 

Number of Lessons – Duration (per lesson):  

Number of Lessons:              2   Duration per Lesson:             45’ 

Subjects: 

For which subject(s) the activity is usable, is it an interdisciplinary activity?  

Science 

 Physics         Chemistry         Biology         Geosciences         Environmental         Other 

Technology 

Engineering 

Arts 

Mathematics 
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Information about the Scenario 

Curriculum and country: 

Link of the current activity to the curriculum: 

Country:   Greece   Class:  Secondary  Grade:  9  - 12  

    

Topic:  2D – 3D Surfaces, Spatial Analysis,  

 Surface characteristics 

 

Objectives (Max 100 words): 

Description of the learning objectives 

Some of the key objectives to be addressed through this activity include:  
 
1. The use of Geographic Information Systems to perform important surface analysis 

procedures (i.e., estimate slopes) or to recreate 3D surfaces,  

2. To understand some crucial aspects and spatial characteristics for identifying potential 

landing sites on Mars and the Lunar surfaces. 

 
 
 

Materials (Max 100 words): 

Which resources and materials (software, hardware) are needed?  

  Material: Search Engines, Satellite Images 

  Software: QGIS (qgis2threejs) 

 

Spatial concepts, skills, and abilities: 

Which spatial concepts and skills are covered by the activity? 

Spatial concepts:  

Primitives: Identity/Name                Location       Space/Time 

Simple:     Distance Direction              Connectivity            Movement 

 Boundary         Shape/Area                  Adjacency 

Difficult:   Overlay  Buffer             Topology               Coordinate   

Map           Scale       Shortest Path Navigation 

Surface               Slope/Gradient            Aspect             Contour  

Complex: Interpolation     Map Projection                   Spatial Dependency   

Other: 
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Spatial skills: 

Map literacy 

Navigation/orientation 

Estimating distances and directions 

Recognizing and understanding patterns/Understand and identify models of 

spatial organization 

Select an ideal location based on the given spatial features 

Visualization 

Understand and identify spatial correlations/ dependencies 

Categorize spatial entities/ geographic features and identify hierarchies 

Compare spatial entities and draw analogies among them 

Identify/determine connections/relations 

Understanding scale in space and time 

Delineation of spatial regions/ zones based on given features/ properties 

Short Description 

Navigation/orientation: Finding one’s way in unfamiliar environments, interpreting and 
giving walking and driving directions.  
Estimating distances and directions: Measure paths, weighted distances, angles. 
Map literacy: Using, interpreting/understanding, learning from, and communicating 
acquired spatial knowledge from maps, comprehension of geographic features 
represented as points, lines, or polygons. 
Recognizing and understanding patterns/Understand and identify models of spatial 
organization. Delineation of spatial regions/zones based on given features/properties: 
Regionalization processes, pattern recognition and clustering identification in the 2d 
and/or the 3d world. 
Select an ideal location based on the given spatial features: Single or multi-criteria siting 
and optimal areas identification. 
Visualization: Visualizing spatial entities from written/oral verbal descriptions, from 
their 2d or graphical representations or through mental transformations; such as axis 
rotation or perspective taking. 
Understand and identify spatial correlations/ dependencies: The ability to realize, 
identify and explain patterns, clusters and relevant spatial dependencies. 
Categorize spatial entities/geographic features and identify hierarchies: Identify the 
hierarchical form of data and gradients between spatial entities. 
Compare spatial entities and draw analogies among them: Calculate and compare 
different geometric objects’ shapes, area and boundaries. 
Identify/determine connections/relations: The ability to identify links and common 
characteristics among spatial entities and between humans and spatial entities. 
Understanding scale in space and time: The understanding of changes/transitions 
through space and time for different spatio-temporal scales. 

 

Geospatial concepts and spatial abilities documentation (see Section 3.2): 

http://www.gosteam.eu/wp-content/uploads/2021/05/GOSTEAM_IO1_A1_final.pdf 

http://www.gosteam.eu/wp-content/uploads/2021/05/GOSTEAM_IO1_A1_final.pdf
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Description of the activity in detail 

Question Eliciting Activities 

Provoke curiosity 

Describe ways and materials that teachers will present to their students to attract their 

attention to the topic investigated.  

 Usually, the most effective way to provoke students’ curiosity is by presenting an exciting video 

or a series of photos 

https://www.youtube.com/watch?v=4czjS9h4Fpg 

(Perseverance Rover’s Descent and Touchdown on Mars) 

But how did we manage to get to the final landing stage? 

 

Propose preliminary explanations or hypotheses 

Formulate the scientifically oriented questions that teachers will present to the students to 

trigger their engagement in thinking about the topic investigated based on their existing 

knowledge. Make these questions digitally available and easily usable, e.g., by integrating them 

in the materials described in the previous step. 

 It is best to ask these questions in the context of a relative discussion.  

Is it an easy task to identify potential optimal sites? 

What criteria are needed? 

What is the scope of the mission? 

 

Active Investigation 

Plan and conduct simple investigation 

This is the phase in which students are being prepared for the subsequent phase of 

evidence gathering during observation. 

https://www.youtube.com/watch?v=4czjS9h4Fpg
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Provide the teachers with a specific plan of the investigation that will take place. Offer 

instructions about the activities they students will need to perform and what kind of 

materials they may need. Describe ways to facilitate the students to focus on evidence.  

Provide the students with a specific plan of the investigation that will take place. 

Offer instructions about the activities they students will need to perform and what 

kind of materials they may need. Describe ways to facilitate the students to focus on 

evidence.  

• During this step, students may collect evidence regarding the criteria needed to 

identify optimal landing sites. Delineate which of these criteria are based on the 

surface characteristics and which are not. 

• It is already difficult to gather enough spatial data even for the Earth’s surface, 

thus, consider for Mars. 

• After the criteria identification, students will get introduced to the spatial 

concepts needed to understand (i.e. slope and aspect calculation, geographic 

coordinates etc.). 

 
Support material for both the Martian and the Lunar missions: 

Mars landing: How to Select a Landing Site on Mars 

Mars 2020 Mission: The Perseverance Rover Landing 

China Mars Rover: Why the China Mars rover’s landing site has geologists excited 

Mars: Landing Sites 

Mars Landing: Picking a Landing Site for NASA's Mars 2020 Rover 

Moon landing: Appolo Missions Landing sites 

Moon landing sites: Landing sites Map 

Lunar Surface: Different spatial data representation 

50 Years Ago: Lunar Landing Sites Selected 

https://www.nationalacademies.org/event/03-23-2021/docs/D710F555C5320CC7FAAA7175CB9E63FD3BEFE7503638
https://www.usgs.gov/news/mars-2020-mission-perseverance-rover-landing?qt-news_science_products=3
https://www.nature.com/articles/d41586-021-01340-0
https://sos.noaa.gov/datasets/mars-landing-sites/
https://mars.nasa.gov/mars2020/timeline/prelaunch/landing-site-selection/eight-potential-sites/
https://airandspace.si.edu/explore-and-learn/topics/apollo/apollo-program/landing-missions/sites.cfm
https://moon.nasa.gov/resources/65/moon-landing-sites/
https://quickmap.lroc.asu.edu/?extent=-90,-25.6312682,90,27.005675&proj=10&layers=NrBsFYBoAYchGSIDMz4BYF0QOwK4A2BkA3gL4C6FplFQA
https://www.nasa.gov/feature/50-years-ago-lunar-landing-sites-selected


GOSTEAM Hands-on Activity Template 

 

Criteria for landing sites identification (Search for the criteria): 

Key criteria for potential landing sites, considering ExoMars and Mars 2020 missions. 

Use the following resources to examine for further insights about the problem: 

Selecting Landing site for the Mars 2020 rover  

Mars Landing Site Selection  

 

 

 

 

 

 

 

 

 

 

 

 

Criteria for landing sites identification (Explore the following maps):  

Scale up the difficulty! 

1. Key criteria for potential landing sites, considering ExoMars and Mars 2020 missions. 

2. Landing elevation, dimensions, slopes and aspect.  

3. You can use additional criteria from:  

https://www.mars.asu.edu/data/ (All available data for Mars) 

 

Figure 1: Landing criteria for the ExoMars and Mars2020 

(Source: Pajola et al. 2019) 

 

https://www.researchgate.net/publication/326221620_The_science_process_for_selecting_the_landing_site_for_the_2020_Mars_rover
https://www.nationalacademies.org/event/03-23-2021/docs/D710F555C5320CC7FAAA7175CB9E63FD3BEFE7503638
https://www.mars.asu.edu/data/
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Figure 2: Digital Elevation Model (DEM) of Mars, Source 

 

Figure 3: Terrain slopes on Mars (Inversed image), Source 

 

https://www.researchgate.net/profile/Bryn-Hubbard/publication/251730490/figure/fig4/AS:686972993544192@1540798533164/A-map-of-Mars-with-major-landmarks-and-key-regions-annotated-Place-names-are-marked-on-a.png
https://tharsis.gsfc.nasa.gov/MOLA/Mapping_Results/images/slope_30km.s.gif
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Figure 4: Thermal Emission Spectrometer(TES) Thermal Inertia on Mars 

 

Figure 5: Thermal Emission Spectrometer(TES) Albedo on Mars 
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At this point, based on Figure 1, you can ask students why do they think we need areas 

below or near 0 level, almost flat areas, low albedo, high thermal inertia and minimum 

rock abundance levels for our landing sites? 

Elevation Sufficient atmosphere braking during landing, Potential areas 
covered with water, lower wind speeds 

Slopes Flat areas for safe landing and navigation 

Albedo Rover’s thermal design constraints 

Thermal inertia Avoid landing on a dusty surface 

Rock abundance Absence of rocks during landing to avoid damage 

 

 

Figure 4: Rock Abundance on Mars 

 

Figure 5: Surface elevation and wind speeds on Mars 
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Explaining Slopes estimation: 

For each cell, the Slope tool calculates the maximum rate of change in value from that 
cell to its neighbors. Basically, the maximum change in elevation over the distance 
between the cell and its eight neighbors identifies the steepest downhill descent from 
the cell (see Figure 7 to understand the neighborhood method). 

The output slope raster can be calculated in two types of units, degrees or percent 
(percent rise). The percent rise can be better understood if you consider it as the rise 
(height) divided by the run (horizontal distance), multiplied by 100. Consider 
triangle B below. When the angle is 45 degrees, the rise is equal to the run, and the 
percent rise is 100 percent. As the slope angle approaches vertical (90 degrees), as in 
triangle C, the percent rise begins to approach infinity. 

 

Where: 

θ (radians) = atan⁡(√⁡([dz/dx]2⁡ +⁡ [dz/dy]2)⁡)) 

θ (degrees) = atan⁡(√⁡([dz/dx]2⁡ +⁡[dz/dy]2)⁡)⁡57.29578  

Note: The value 57.29578 shown here is a truncated version of the result from 180/pi. 

The neighborhood algorithm estimates percent slope at grid cell e (Figure 6) as the sum 
of the absolute values of east-west slope and north-south slope. 

The values of the center cell and its eight neighbors determine the horizontal and 
vertical deltas. The neighbors are identified as letters from a to i, with e representing 
the cell for which the aspect is being calculated. 

The rate of change in the x direction for cell e is calculated with the following algorithm: 

[dz/dx] = ((c + 2f + i) - (a + 2d + g) / (8 x_cellsize) 

The rate of change in the y direction for cell e is calculated with the following algorithm: 

[dz/dy] = ((g + 2h + i) - (a + 2b + c)) / (8 y_cellsize) 

See Figure 6 to understand what the parameters a-i are express as also, the cell size 
that is “translated” as the pixel’s size 

Figure 6: Slope estimation in degrees and percent of slope 

 

https://desktop.arcgis.com/en/arcmap/10.3/tools/spatial-analyst-toolbox/slope.htm
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The cell size is 1 unit. The default slope measure of degrees will be used. 

[dz/dx] = ((50 + 60 + 10) - (50 + 60 + 8)) / (8 * 1) = 0.05 

[dz/dy] = ((8 + 20 + 10) - (50 + 90 + 50)) / (8 * 1) = -3.8 

rise_run = √⁡(0.052 ⁡+ ⁡(−3.82)) = 3.80032 

slope_degrees = atan(3.80032) * 57.29578 = 75.25 

Important note: If there is a cell location in the neighborhood with a NoData z-value 
(height value), the z-value of the center cell will be assigned to the location. For 
example, at the upper left edge of the raster (value 50 in Figure 6 - Heights), consider 
that 5 neighbours are missing (NoData). Hence, we create 5 pseudo-cells and we assign 
the value of the cell we want to estimate slope (i.e. 50). 

An indicative example of a slope surface is demonstrated in Figure 8. You can see that 
areas of increased altimeter (white color) are expected to result increased slopes (red 
colors on the right image) because of the steep surfaces occurred near the peak of the 
mountains. 

 

 

Figure 7: Slope estimation based on the neighborhood method 

 

Figure 8: Elevation raster and extracted slope raster example 

 

Cell e neighboors a-i Heights (DEM) Slopes 
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Creation 

Gather evidence from observation 

The selected resource (e.g., a simulation, an experiment, an animation, a graph, or other exhibit 

of similar nature) must provide students with an opportunity to collect evidence addressing the 

scientific questions presented in previous stages through direct or indirect observation. Provide 

guidance to the teacher organize and manage the activity most effectively and efficiently.  

It is recommended to introduce group work at this stage. Guide the teachers to divide 

students in groups, each of which will be facilitated by the teacher to formulate and to evaluate 

explanations to the scientific questions based on the collected evidence.  

 

Preparative steps 

1. Download QGIS 3.18.1 version  

2. Download Mars DEM data 

    Download Lunar DEM data 

 

The above-mentioned DEM datasets have increased accuracy and size. It is much 
easier to test the activity with the resampled datasets you can find on the link below: 

https://drive.google.com/drive/folders/1S-
RGqCzWnnOEOIYJTG8RfSwSy9CMgPYx?usp=sharing 

You can select to download Mars DEM folder. The file you will work with is 
‘Mars_DEM_5000.tif’ 

Part 1 (Open QGIS) 

Some technical guidelines considering the tools (QGIS Platform) we will use during this Activity! 

Load data: In general, data can be loaded in four ways. The first way (Figure 8-selection 2) is to 

use the Layer > Add Layer menu and select the appropriate type of data you wish to load. The 

second way (Figure 8-selection 1) is to open the Browser panel, navigate to the data you wish 

to load, and then drag the data on to the map display, or on to the Layers panel. The third way 

(Figure 8-selection 6) to load data is to enable the Manage Layers toolbar and click on the 

Students can work in groups of three where each member of the group is responsible 

for:  

1) data collection (maps, spatial data etc.)  

2) previous missions’ landing criteria, scope and objectives and finally, 

3) future missions’ objectives and goals. 

https://astrogeology.usgs.gov/search/map/Mars/Topography/HRSC_MOLA_Blend/Mars_HRSC_MOLA_BlendDEM_Global_200mp_v2
https://astrogeology.usgs.gov/search/details/Moon/LRO/LOLA/Lunar_LRO_LOLA_Global_LDEM_118m_Mar2014/cub
https://drive.google.com/drive/folders/1S-RGqCzWnnOEOIYJTG8RfSwSy9CMgPYx?usp=sharing
https://drive.google.com/drive/folders/1S-RGqCzWnnOEOIYJTG8RfSwSy9CMgPYx?usp=sharing
https://qgis.org/downloads/
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button representing the data type you wish to load. The fourth way is to locate the data in QGIS 

Browser, drag to the data, and drop it onto the QGIS Desktop Map Display or Layers panel 

(Source: https://www.gislounge.com/loading-data-mastering-qgis/). 

 

 

 

Part 2 – Load Mars surface data (Digital Elevation Model) 

Mars surface data – DEM – Simplified scenario: 

1. During the first step of the Activity, load Mars surface data in the QGIS platform. 

2. Use the Main toolbar (top of the screen) -> Layers -> Raster Layer -> Navigate to 

your folder and select Mars_DEM_5000.tif 

3. Change layout colors using Layer Properties (double-click on the .tif image you’ve 

loaded) -> Symbology -> Single-band Pseudocolor -> Classify. 

4. Identify mountains and pits, find altimeter values (identify button). 

 

 

 

Figure 9: QGIS interface and some key functionalities 

 

https://www.gislounge.com/loading-data-mastering-qgis/
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Part 3 – Install new Plugins: 

To begin using plugins, you need to know how to download, install and activate them (Figure 

6). To do this, you will learn how to use the Plugin Installer and Plugin Manager. But what a 

Plugin is?  

Plugins in QGIS add useful features to the software. Plugins are written by QGIS developers and 

other independent users who want to extend the core functionality of the software. These 

plugins are made available in QGIS for all the users (Source: QGIS Tutorials). 

Install qgis2threejs plugin: 

Plug-ins > Manage and Install Plugins > See the image below and Figure 10. 

 

Source: https://www.istockphoto.com/photos/mars-
white-background 

Figure 9: Map surface in reality and as a projected map 

 

https://www.qgistutorials.com/en/docs/using_plugins.html
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Part 4 - Mars DEM Reclassify heights: 

Reclassify DEM heights using “Reclassify by Table” tool: 

Click on the Processing Toolbox icon 

 

 

 

On the Processing Toolbox window on the right, type “Reclassify” and select the 
Reclassify by Table tool. 

1. Click on Plugins on the Main Toolbar 

2. Select Manage and Install Plugins 

3. All Plugins 

4. Type “qgis2threejs” 

5. Select it 

6. Click “Install Plugin” 

Figure 10: Plugin Management window 
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On the Reclassify by Table window select as raster layer > Mars_DEM_5000 

Click on the Reclassification Table and insert the criteria of Figure 11 

 

 

 

Mars DEM Reclassify Results: 

 

Figure 12 presents the results of the reclassified DEM values. At this point you can ask 

from students to connect the values of the reclassified raster (0,10) with the Table they 

used in the Reclassify by Table tool (Figure 11). 

 

Figure 11: Reclassify by Table window 

 

1. Input layer “Mars_DEM_5000” 

2. Reclassification rules 

3. Save layer 

Figure 12: Reclassified DEM results with the value of 0 for the non-suitable 

areas and 10 for the suitable 
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Part 5 – Estimate Mars Slopes: 

Estimate slopes on Mars using Raster Analysis Tools! 

Navigate to Raster > Analysis > Slope (see Figure 14) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 13: Slope tool parametrization 

 

1. Input layer “Mars_DEM_5000” 

2. Save layer as “Mars_Slope” 

Figure 14: Slope results in the range between 0 – 25.75 degrees 

 



GOSTEAM Hands-on Activity Template 

 

When we estimate the slopes, we look back to the criteria table (Figure 1) and we focus 

on the slopes’ threshold values! For instance, we want to identify areas where the 

slopes are below 2 degrees or 5 degrees etc. To succeed that, we will also reclassify the 

slopes raster surface (as DEM) using the instructions of Figure 15. 

 

Part 6 – Slopes Reclassification: 

On the Reclassify by Table window select as raster layer > Mars_DEM_5000 

Click on the Reclassification Table and insert the criteria of Figure 15/ 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

Figure 15: Slopes reclassification tool parametrization 

 

1. Input layer “Mars_slope” 

2. Reclassification rules 

3. Save layer 

Figure 16: Slopes reclassification resulted map, red areas (suitable 10), blank areas (unsuitable 0) 

 



GOSTEAM Hands-on Activity Template 

 

Now that we have the reclassified areas of the Martian surface, based on the DEM and 

slopes data, we can overlay the results and identify an optimal area that meets all of 

the criteria of Figure 1 (considering also the albedo, thermal inertia and rock abundance 

maps)! 

Step 7 - Dem and Slope overlay: 

Actually, we are searching for areas that lay within both the red and the blue colors 

(areas that meet the reclassification rules with a value of 10 as suitable). 

 

Final steps consist of selecting and “cutting” one specific area that we consider as the 
optimal one!  

Part 8 (Create Mask Layer) Next step consists of cutting/clipping a specific area of 
interest; thus, we must create a new empty shapefile layer and create a polygon mask! 

Why? To differentiate students’ results and 

trigger their interest upon different areas! 

 

 

 

Create an empty polygon shapefile and edit an 

area you consider as the most suitable as 

illustrated in Figure 18. 

 

 Figure 18: Create a new empty shapefile 

 

Figure 17: DEM and Slopes overlay 
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After selecting to create a new Shapefile the following window will appear (Figure 19). 

All you have to do is to select a path to save your new file (save as Mask.shp), to set the 

shapefile geometry type (polygon) and finally, to select the appropriate coordinate 

system. 

 

 

Part 9 – Edit/Digitize your optimal area as Polygon 

Load your new empty shapefile (Mask.shp) 

Select the new layer on the Layers menu and click on “Toggle Editing”. 

 

 

Click on “Add Polygon” and draw a Polygon that will be used as a Mask. 

 

 

 

Figure 19: Create a new empty shapefile window 

 

1. Select folder to save your file and save as “Mask.shp” 

2. Select Geometry > Polygon 

3. Select Coordinate System > Equirectangular_Mars 

4. Click OK 
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On your Map screen a cross inside a circle will appear and you can star digitizing your 

Polygon area. To the final point you edited, press right-click by adding number 1 as the 

Polygon “id”.  

Part 10 – Use the qgis2threejs Plugin to extract and visualize in 3D the results 

Select the qgis2threejs icon in order to load the plugin 
window. 

Then, the window, as illustrated in Figure 20 will appear! 

 

As you can see on Figure 20, the main drawing window is empty. In order to load and 

visualize a file, you have to select the file (Mars_DEM_5000) on the left panel! 

 

 

First you can modify the Scene settings! 

You can select for the base case scenario the values illustrated on the below Figure, by 
setting the Base width and Vertical exaggeration as 100. 

You can always press Apply to all changes you make to see the updated result. Also, 
you can change the Vertical exaggeration value to 1, 10 and 1000? You can also disable 
the Outline effect box! 

Can you spot the differences and why the Vertical exaggeration value is used for? 

See the results in Figure 21! 

Figure 20: Qgis2threejs interface window 

1. Scene settings set-up 

2. Right-click Layer properties set-up 
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Now right-click on the Mars_DEM_5000 layer and a new window will appear as 

illustrated in Figure 22! 

Now you can clip the Martian surface on the polygon extent that you have already 
created during the previous step! 

Use Clip DEM with polygon layer and select “Apply”. You can also change the 
Resampling level, you can click on “Enable shading” or modify the Other Options 
preferences. 

 

Figure 21: Mars surface visualized using qgis2threejs 

Figure 22: Clipped landing area using qgis2threejs 

Double-click on your clipped area and 
select “Orbit around here!!” 
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Inspect the final landing area to see if there are mountains or hills, craters and overall, 

if it is a flat and safe area for landing! 

 

Discussion 

Explanation based on evidence 

Encourage your students to provide correct explanations for the topic(s) investigated.  

Describe ways and they can use to this end and give them directions how to discover them. 

Find previous landing sites on Mars (or the Moon) and compare your results.  

Source: http://redplanet.asu.edu/?p=33040 

• How do you explain the spatial distribution of the landing sites on Mars? 

• Can we apply the same procedure for the Lunar surface? 

• Which objectives change and what is the purpose of a Lunar Mission? 

 

http://redplanet.asu.edu/?p=33040
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Consider other explanations 

Facilitate the student groups to evaluate their own explanations in the light of alternative 

explanations, particularly those reflecting scientific understanding. Illustrate examples they can 

use and give them instructions how to locate them.  

 

Reflection 

Communicate explanation 

Guide teachers to facilitate each student group to reflect on the previous experiences and to 

produce a report with its findings, presenting and justifying the proposed explanations to the 

other groups and the teacher. 

Provide content which the teacher can use to help the students to get familiarized and to 

become efficient in scientific writing. 

Students can deliver a short report of previous missions landing sites, the selected 

criteria for these missions and the objectives. 

They can link the criteria with different spatial aspects by reviewing and discussing 

in parallel the criteria they used, the geophysical characteristics in the landing site 

they propose etc. 

Computer Vision on Mars 

Mars Rover movement algorithms 

 

Follow-up activities and materials 

Describe and direct the user to any follow-up activities or materials that can be used to wrap-

up the hands-on activity.  

These could include appropriate learning assessment and/or reminder materials (e.g.,  

quizzes, games, other user-friendly tests), hints for further activities etc. 

https://www.ri.cmu.edu/pub_files/pub4/matthies_larry_2007_1/matthies_larry_2007_1.pdf
http://www.cs.ait.ac.th/~mdailey/cvreadings/Carsten-MarsPath.pdf


GOSTEAM Hands-on Activity Template 

 

Moon surface data – DEM: 

 

Source: 

https://www.shutterstock.com/el/search/moon+white+background 

 

 

 

Sustainable contact 

Loukas Katikas (lkatikas@ea.gr) 

 

References (if any): 

 

Assessment (if any): 

 


